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TALKBACK INTERCOM SYSTEM 

V-2928 OPTION BOARD 
 

The V-2928 Option Board is an add-on feature for the V-2924A Expandable Zone Talkback Intercom 
System.  The addition of this board provides the following supplemental features: 
 
• Time sync output 
• Custom page groups 
• Enhanced Caller ID 
• Flexible Architectural numbering plan 
• Interface to the PC Programming Tool 
• Store user data to EEROM 

• Real time clock for SMDR printer 
• Auto detect for Com Port or Modem 
• Auto adjust for Daylight Savings Time 
• Evacuation tone to specified groups 
• Time tones to any of the Pre-Determined 

Groups selected 
• Read software/firmware revision numbers 

Dimensions/Weight     
• 5.3" L x 3.00" W x 1.10" D 
• (13.46cm L x 7.62cm W x 2.79cm D)  
• 0.9 lbs (0.41 kg) 

 
The V-2924A Programming Tool is a windows based 
software tool designed to interface with the V-2928 
Option Board.  The Option Board and the Programming Tool must both be installed to access the 
additional features provided by the Option Board.  All features must be set with the Programming Tool 
when the Option Board and Programming Tool are installed. 
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INSTALLATION OF THE OPTION BOARD 
The Option Board must first be installed on the Control Unit Board  (See Figure 1). 
 
WARNING:  Disconnect main power before servicing. 
 
• Remove the side plate and top cover of the Control Unit and set aside. 
• Slide small side plate upward to provide opening for Option Board connector (See Figure 1). 
• Align J3 on the Option Board directly over  J1 on the Control  Board. 
• Align J4 on the Option Board directly over JP2 on the Control Board. 
• Press Option Board firmly in place to make sure connectors are seated properly. 
• Replace the top cover and side plate of the Control Unit and plug in the power supply. 
• Plug PC Communication Cable (included) into P1, PC Programming Port (located on the Option 

Board - See Figure 1). 
 
The V-2928 Option Board requires the use of the PC Programming Tool to access the various features it 
provides. 
 
INSTALLATION OF THE PROGRAMMING TOOL 
Minimum Computer Requirements for the Valcom V-2924A Programming Tool: 
Hardware: 

• Pentium (higher is recommended) 
• Hard drive with 60 Mbytes free 
• Mouse 
• 64 Mbytes of RAM (more is recommended) 
• 1 available serial communication port 

 
Operating System: 

• The Programming Tool is compatible with Windows 98, ME, NT.4.0,Windows 2000 and 
Windows XP. 

 
 Rev 2 Programming Tool is compatible with previous versions of hardware, however, the new 
hardware is not compatible with previous versions of the Programming Tool. 
 
The programming tool software is furnished on CD and must be installed to the hard drive.  To install the 
software: 

• Insert Programming Tool CD. 
• CD will Auto Run. 
• Follow on-screen instructions for full installation. 
• The Valcom V-2924sc Programming Tool will automatically appear in the Programs list. 
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Align J3 on the Option Board directly over J1 on the Control Board
Align J4 on the Option Board directly over JP2 on the Control Board
Press Option Board firmly into place. 

                     FIGURE 1 - OPTION BOARD LOCATION ON THE V-2928 CONTROL BOARD

Side View

Top View
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USING THE PROGRAMMING TOOL 

• On the taskbar, click the Start button, point to Programs and select VALCOM V-2924sc 
      Programming Tool. 
• The V-2924 Programming Tool splash screen appears momentarily and then the Programming 

screen comes into view. 
 

 
 
System Configuration 
To begin the programming process, click on File.  A pull-down menu appears allowing selection of a previously 
programmed file (click on Open) or the ability to create a new file (click on New).  The following instructions 
assume a New configuration file is being created.  Click on New from the pull-down menu.  A System 
Configuration screen is displayed to allow selection of the installed components within the system. 
 
Select one of the following from the list: 
• For a 24-station system select Main Board. 
• For a 48 station system select Main Board + Expansion 1. 
• For a 72 station system select Main Board + Expansion 1, 2. 
• For a 96 station system select Main Board + Expansion 1, 2, 3. 
 
Click in the box next to Clock Board if the V-2927 Clock Control Card is installed. 
 
Press OK to accept the present selection or Cancel to re-select.  When selection is complete, the Programming 
Window Screen will be displayed.  (To display the configuration of the system press the Details button). 
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When OK is selected from the System Configuration screen, the Programming Window appears - see below.  The 
Programming Window allows each option to be accessed by selecting the option and pressing Open or by double 
clicking on the selected option.  All functions can be listed at once by pressing Open All.   (All of the options 
accessed through the Programming Window can also be accessed from the pulldown menus). 
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Architectural Number and CLID (Caller ID) Programming 
The first function to configure is the Architectural Number and CLID Programming.  
 
The Architectural Number is a 1 to 4 digit number that is dialed by the phone to connect to a specific speaker.  
Flexible architectural numbering is often selected to allow speakers and room numbers to match.  The CLID 
Programming allows a name or up to 15 characters description to be entered for each station. 
 
The information entered in the CLID description field will be displayed on the phone or Caller ID unit if provided as 
part of the system. 
 
The Edit Station Entry allows a CLID description to be entered for each station.  Example:  105  would be the 
Arch # and  MR. HALL  would be the CLID description (15 character limit). 
 
The Delete Station Entry allows removal of selected architectural and CLID descriptions. 
 
Auto Numbering assigns the Arch # in sequential order.  The beginning number is the currently selected station; 
an ending number must be specified. 
 
To Auto Number – Highlight station where architectural numbering begins. 
 Select Edit Station Entry.  Enter beginning architectural number and select OK. 
 Select Auto Numbering and enter last architectural number (must be a higher number). 
 Select OK. 
 
Enter information for the Main Board as well as each Expansion Unit being used and press OK to accept. 
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Audio Connections  
This screen allows selection of groups to receive Background Music, Time Tones and Emergency Tones. 
This sample system consists of a "Main Board + Expansion 1" so eight groups are available to receive audio 
connections.  (Each group contains six stations). 
 
 

Group 1 Stations 1, 2, 3, 4, 5, 6 Main Board 
Group 2 Stations 7, 8, 9, 10, 11, 12 Main Board 
Group 3 Stations 13, 14, 15, 16, 17, 18 Main Board 
Group 4 Stations 19, 20, 21, 22, 23, 24 Main Board 
Group 5 Stations 25, 26, 27,  28, 29, 30 Expansion 1 
Group 6 Stations 31, 32, 33, 34, 35, 36 Expansion 1 
Group 7 Stations 37, 38, 39, 40, 41, 42 Expansion 1 
Group 8 Stations 43, 44, 45, 46, 47, 48 Expansion 1 

 
 
Click on the tab of the desired feature to program zones.  Click on each group button to receive the audio 
connection.  If all groups are to receive an audio connection for the specific feature, select Include All. 
 
The zones for each feature:   
BGM, Time Tone and Emergency, are selected in the same manner. 
 
Defaults:   BGM   - All Off 
  Time Tone - All On 
  Emergency - All On 
   
After zones for each feature have been selected, press the OK button. 
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The Audio Connections screen disappears, with the Programming Window still being active to allow selection 
of other options. 
 
Class of Service. 
Class of Service defines how a call originated by a button press will be queued for answer by the attendant.   
 
• Emergency Only - Top priority.  Stations programmed as Emergency Only are moved to the top of the 

priority list to be answered first.   
• Normal/Emergency - Calls from stations programmed as Normal/Emergency are received in the queue as 

they are made.  1 button press from the station, the call is received as a normal call; 4 button presses from 
the station, the call is received as an emergency call. 

• Normal Only - Calls from stations programmed as Normal Only are received in the queue as Normal priority 
whether 1 or 4 button presses are made at the calling station. 

 
Set the Class of Service for all Groups on the Main Board as well as any Expansion Boards.  Press the down 
arrow at the end of the Class of Service field to display the available types of service for selection. 
 
When finished, press the Close button. 
 
Default option of all stations, with or without the Option Board installed, is Normal/Emergency.   
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Clock 
Note: Clock programming option is available if Clock Board has been checked on System Configuration screen.  
Clock correction is only available with the V-CLK2924 Clock Correction Kit. 
 
When Clock is selected, the following screen is displayed. 
 
Click on the tab for Clock A.  Then click on the down arrow next to Clock Type, and select the clock type code 
(codes are defined in the V-2927 manual) for the Clock Circuit 1 connections on the V-CIO.  If using the Clock 
Circuit 2 connections on the V-CIO, click on the Clock B tab, and select the clock type code for those connections.   
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Custom Page Groups 
When Custom Page Groups is selected, the following screen is displayed. 
 
There are 4 Custom Page Groups available. 
 
Select the Page Groups to receive custom paging by clicking on the desired box.  Each Custom Page Group 
can contain all groups or a combination of groups.  (Example:  Custom Page Group 50 could contain page 
groups 1, 2 and 3, and Custom Page Group 52 could contain page groups 1, 2, 7 and 8). 
 
Select OK after all desired page groups are defined. 
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Master Clock Schedule 
The Master Clock Schedule has 6 separate schedules with up to 256 total events.  The user defines how these 
events are to be distributed between schedules. 
Dial codes may be used to force a schedule or to turn a schedule off.  #94X forces schedule on with the X being 
the number of the schedule (i.e. #941 will force Schedule 1).  #940 turns off the active schedule. 
 
• Select Schedule 1-6. 
• Click Open. 
• Displays Schedule 1 menu. 
• Choose which "days" schedule is to be active. 
• Select Add. 
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New Event Screen menu will be shown.  Select Start Time.  Select which Relay Type you want to follow the 
Schedule and Select the Relay Duration of the contact closure.  Select which Page Group(s) tone should go to.  
Select Save. 
 
NOTE:  The contact closure pairs 13, 14, 15, 16 on the system punchdown block, should be wired to the tone 
select input of an external tone generator (V-9927A).  The tone output of the external tone generator should 
then be wired to the external tone input of the V-2924A, pair 5 of the system punchdown block. 
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System 
Note:  If Clock Board was checked in system configuration, you will need to scroll down to find System in the 
Programming Window. 
 
Next select System from the Programming Window.  A check in the box means ON (selected); an empty box 
means OFF (not selected).  Select the desired options and click on OK to exit this screen.  The options are 
described in more detail in the Control Unit (V-2924A) document or select Help from the pull-down menu for 
on-screen details. 
 
The Dip Switch button displays the dip switch equivalent (see next page) of the options selected with the 
programming tool. 
 
IMPORTANT:  Options set using the programming tool override options selected manually using the 
Control Unit dip switches. 
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Dip switch equivalent of programmed options.  
 

 
 

 
Save Programmed Data to a File  
When the programming selections are complete, click on the File menu option to access the pull-down menu 
and select Save.  Define file name and location and press Save. 
 
 

A
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COMMUNICATING WITH THE V-2924A 
Communicating with the V-2924A allows sending and receiving of user programmed data, Setting of 
System Date and Time and reading the revision numbers of the system firmware. 
 
Once system programming is complete, this data must be downloaded to the V-2924A System.  This 
communication can be accomplished through two methods: 
 
Initiating Communications 
Direct Connect (PC is on site with the V-2924A System - can be accessed via a Null Modem RS232 cable). 
To Connect:  
Connect cable from the V-2924A to the PC being used. 
Set up Com Port (page 15). 
Connection complete. 
 
Modem Connect (PC is off site or can only be accessed using phone lines to communicate). 
To Connect: 
Set up modem (User required procedure - page 15). 
Set up Com Port (page 15). 
Select Dialing Method: 
• Modem Connect (page 15) 
• Manual Connect (page 16) 
 
REMINDER: 
For a modem to communicate with the V-2924A, there must be a remote modem connected to the 
V-2924A.   See page 18 for Setup of the Remote Modem. 
 
Direct Connect  - Set Up Com Port 
Select File, Com Setup, Com  Port Selection. 
 
If the port is known, use the down arrow to locate the number, select it and press OK. 
 
If the port is not known, select Auto Find. 
 
Reminder: 
If direct connect is being used, make sure cables are connected and V-2924A is on. 
If modem connect is being used, make sure modem is installed and working properly. 
 

 
 
Modem Connect 
From the Programming Tool, select File, Modem and then Modem Connect. 
 
The screen below appears.  Enter the number to dial or select a phone number from the list displayed. 
Numbers can be added, edited or deleted from the list.  Up to 10 numbers can be stored. 
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Once the desired phone number is displayed in the Number to Dial field, click on the Dial button.  Messages 
should be displayed stating, "Initializing", "Dialing" and  "Modem Connection Successful".  Click on OK. 
 
If modem fails to connect, verify modem was set up properly during system installation.  Refer to section titled, 
"Setup of the V-2924A Modem," page 18. 
 

 
 
Manual Connect 
From the Programming Tool, select File, Modem and Manual Connect.  Follow the instructions as described 
on the screen. Messages should be displayed stating, "Initializing", "Dialing" and "Modem Connection 
Successful".  Click on OK. 
 

 
Send data to V-2924A 
From the main menu, select Send Data to V-2924.  If a file is open, that file will be sent to the V-2924A System.   
If no file is open when Send Data to V-2924 is selected, the screen appears to allow selection of the data file to 
be opened and downloaded to the V-2924A.  Highlight the desired file and click on OK. 
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Receive Data from V-2924A 
From the main menu, select Receive Data from V-2924.  This will take place automatically.  If you are not 
allowed to select Receive Data from V-2924, close the currently open file and try again.   Messages will be 
displayed stating Receiving Data, Receive Data Completed Successfully.  Click on OK. 
 
 
Set System Date and Time 
Set System Date/Time by clicking on the Date/Time pull-down menu.  Up/Down arrows are used to move date 
and time to the desired setting.  Press Update to set the new Date/Time or Cancel to leave unchanged.   The 
Automatic DST Adjustment can be enabled or disabled here. 
 

 
 
Read Software and Firmware Revision Numbers 
This feature is accessed through the Help menu.  Select Help, then About.  This option provides information 
for all processors. 
 
Reminder:  The PC must be connected to the system to access this information. 
 

 
 
Ending Communications 
Direct Connect:  No action required, just unplug cable. 
Modem Connect: From the pulldown menu, select File, Modem, Modem Release. 
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SETUP OF THE V-2924A MODEM 
1. To transfer data from a PC through a modem to the V-2924A System, the Remote Modem must be setup.  

THIS IS A "ONE-TIME" PROCEDURE THAT SHOULD BE PERFORMED WHEN THE MODEM IS 
INSTALLED.  Select Communications Setup from the File Menu as shown in the following screen display: 

 

 
2. Select Remote Modem Setup and the following screen is displayed: 

 
3. If Yes is selected, the dip switches at the back of the modem must be set to the positions shown below.  

Press OK to continue. 
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The following screen is displayed after selecting No from the question of using a US Robotics modem or after 
selecting Yes, setting the dip switches  and pressing OK. 
 

 
 
4. Complete the instructions on the screen and click OK.  The next screen to be displayed requests selection 

of a COM Port.  Select the proper COM Port and click OK. 
 

 
 
The program then attempts to test the communication line between the PC and the modem.  If the connection is 
okay, continue to Step 5.  If the connection fails, you can Abort the setup, Retry the setup or Ignore the warning. 
 
5. After establishing a successful connection, restore the modem's factory default settings as shown below by 

clicking on Yes. 
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6. The default modem commands for the US Robotics Sportster appear below.  Click on Enter to send 
these commands to the modem. 

 

 
 
7. Save the settings to the modem's memory by selecting "Yes" as shown in the figure below. 
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8. If "Yes" was selected in step 2, now with the modem power OFF, set the dip switches to the settings 

shown below and then click on OK.  For a description of "DIP" switch functions, refer to the table below. 
 
 

 
 
 

Dip Switch 
Number 

Description 

SW1 Override DTR 
SW2 Verbal Result Codes 
SW3 Suppress Result Codes 
SW4 Echo Offline Commands 
SW5 Auto Answer on Ring 
SW6 Carrier Detect Normal 
SW7 Load NVRAM Defaults on Power-up 
SW8 Smart Mode 

 
 
9. After modem setup is complete, the screen below appears verifying a successful setup. 
 

 
 
MENU OPTIONS 
 
PRINT 
The print option allows the system to provide a hard-copy verification of how the system is programmed. 
To print, the PC must be connected to a printer via the RS-232 serial printer port (DB9 connector). 
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To access this option, select File and then Print.  A screen (shown below) appears to allow selection of 
all programmed options or individual options for printing. 
 
This screen shows all items selected for printing. 
 

 
 
WINDOW 
The pull-down menu titled Window, allows several screens to be closed at once.  Instead of going through 
several open screens, closing them individually, select Window, Close All or select the screens individually 
from the pull-down window. 
 
HELP 
The Help pull-down menu provides on-screen definition of elements provided by the V-2924A Talkback 
Intercom System.  Select Help, select Contents.  Click on General Description, Definitions or Detailed 
Information to view the list of topics available through the Help menu.   
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EXIT 
Select Exit from the File pull down to close the Programming Tool.  
 
TECHNICAL ASSISTANCE 
When trouble is reported, verify that power is being supplied to the unit and there are no shorts or grounds 
on cabling. 
 
Assistance in troubleshooting is available from the factory.  When calling, have a VOM and a telephone 
test set available and call from the job site.  Call (540) 563-2000 and press 1 for Technical Support or 
visit our website at http://www.valcom.com. 
 
Valcom equipment is not field repairable.  Valcom, Inc. maintains service facilities in Roanoke, VA.  Should 
repairs be necessary, attach a tag to the unit clearly stating company name, address, phone number, 
contact person, and the nature of the problem.  Send the unit to: 
 

Valcom, Inc. 
Repair and Return Dept. 

5614 Hollins Road 
Roanoke, VA  24019-5056 

 
 
 

 
VALCOM LIMITED WARRANTY 

Valcom, Inc. warrants its products to be free from defects in materials and workmanship under conditions of normal use and service 
for a period of one year from the date of shipment.  The obligation under this warranty shall be limited to the replacement, repair or 
refund of any such defective device within the warranty period, provided that: 
 
1. inspection by Valcom, Inc. indicates the validity of the claim; 
2. the defect is not the result of damage, misuse or negligence after the original shipment; 
3. the product has not been altered in any way or repaired by others and that factory sealed units are unopened (a service 

charge plus parts and labor will be applied to units defaced or physically damaged); 
4. freight charges for the return of products to Valcom are prepaid; 
5. all units ‘out of warranty’ are subject to a service charge.  The service charge will cover minor repairs (major repairs will 

be subject to additional charges for parts and labor). 
 
This warranty is in lieu of and excludes all other warranties, expressed or implied, and in no event shall Valcom, Inc. be 
liable for any anticipated profits, consequential damages, loss of time or other losses incurred by the buyer in connection 
with the purchase, operation or use of the product. 
 
This warranty specifically excludes damage incurred in shipment.  In the event a product is received in damaged condition, the 
carrier should be notified immediately.  Claims for such damage should be filed with the carrier involved in accordance with the 
F.O.B. point. 
 
 Headquarters: In Canada 
 Valcom, Inc. CMX Corporation 
 5614 Hollins Road 35 Van Kirk Drive #11 and 12 
 Roanoke, VA 24019-5056 Brampton, Ontario L7A 1A5 
 Phone:  (540) 563-2000 Phone:  (905) 456-1072 
 FAX:  (540) 362-9800 FAX:  (905) 456-2269 
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CONTACT CLOSURE CONNECTIONS * TO P7 FROM THE OPTIONS CARD

Block P7-System Inputs

* Available only with Options Card Installed.
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